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Introduction
1.1

Overview
The UCD90xxx family of digital power-supply sequencers from TI, also known as system health monitors,
are flexible and powerful enough to meet user's sequencing, monitoring, margining, and other needs. The
TI Fusion Digital Power Designer is a dedicated graphical user interface (GUI), tool which helps users
configure and monitor UCD90xxx sequencers/health monitors without coding knowledge. This document is
targeted for Fusion Digital Power Designer 7.0 or newer. It can be a useful reference for the older 2.0.xxx
Fusion GUI, but the layout and interface may not be the same as described in this document.
The TI Fusion Digital Power Designer has the following features:
• Windows®-based application, supports Windows 7
• Design, configure, and monitor TI digital-power controllers and sequencers/health monitors using a TI
USB adapter
• Supports multiple devices in the same bus in online (connected to live devices), offline (file-base virtual
devices), and hybrid mode (combination of online and offline mode)
• Exports the configuration of the device to different file formats for third-party programming
• Supports command line tools for scripting and automation
The entire family of devices is designed to have similar behavior, with different numbers of rails or some
minor features. Users need only to learn how to use the device once, and then they can seamlessly switch
to other devices within the family that best fit future designs. This document is a reference guide to give
users a jump start, and applies for all UCD90xxx devices (except UCD9080 and UCD9081).

Windows is a registered trademark of Microsoft Corporation.
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Installation
2.1

Fusion Digital Power Designer
Click here for the latest Fusion Digital Power Designer software. Perform the following steps to install the
software (see Figure 2-1).
1. Double-click TI-Fusion-Digital-Power-Designer-7.0.x.exe to run the install.
2. Accept the License Agreement and click the Next button.
NOTE: By default, the software is installed in C:\Program Files (x86)\Texas Instruments\Fusion
Digital Power Designer. However, you can relocate it to a different folder so that each
version of the fusion digital power designer is separately installed.

3. Select the option to create a shortcut on Start Menu.
4. Select the option to create more shortcuts for other tools and add the Fusion GUI directory in the
system PATH. TI recommends checking both the SAA Debug Tool and UCD3xxx UCD9xxx Device
GUI.

Figure 2-1. Fusion GUI Installation
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If this is your first time using the Fusion GUI, a pop-up introduction window will appear (see Figure 2-2).
Click OK to proceed to using the Fusion GUI.

Figure 2-2. GUI Mode Options

2.2

USB Adapter Firmware
Currently, the Fusion GUI supports the TI USB-to-GPIO adapter. The adapter can be added as an
individual dongle (see Figure 2-3) or built into some of the EVM boards, shown in the following images.
For the USB adapter as a dongle, the USB cable is connected on one end to the PC on the USB port, and
on the other end it is connected to the dongle. The 10-pin ribbon is connected to the dongle and to the
EVM 10-pin header. For some UCD90xxx EVMs, the USB adapter is built in with the EVM. Remove the
dongle, then connect the USB cable directly to the USB connector on the EVM board.

USB Cable

LED Indication
USB Attached

Figure 2-3. USB-to-GPIO Adapter
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The Fusion GUI supports the TI USB-to-GPIO adapter, firmware version 1.0.x. If however, the firmware
version on the USB adapter is not 1.0.x, you can download the USB adapter firmware by launching the
USB Adapter Firmware Download Tool and selecting Start Menu → All Programs → Texas Instruments →
Fusion Digital Power Designer → Tools → USB Adapter Firmware Download Tool (see Figure 2-4). TI
recommends using version 1.0.13 because it supports up to 58 bytes of data package, which is required
by UCD90320 devices (see Figure 2-5).

Figure 2-4. Adapter Firmware Download Tool (1/2)

Figure 2-5. Adapter Firmware Download Tool (2/2)
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Fusion GUI Mode
The Fusion GUI supports online, offline, and hybrid mode for various applications (see Figure 3-1). As the
term suggests, a live device is required for online mode and hybrid mode.

PC with Fusion GUI installed

USB to GPIO Dongle

Figure 3-1. Typical GUI Application

3.1

Fusion GUI Offline Mode
The Fusion GUI can store the configuration of a device, along with GUI-centric configuration data, such as
design input parameters, in a project file (see Figure 3-2). This lets users design the power system without
real devices. Users can launch offline mode by selecting Start menu → Texas Instruments → Texas
Instruments Fusion Digital Designer → Fusion Digital Power Designer Offline Mode.

Figure 3-2. Fusion Digital Power Designer Offline Mode
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When the offline GUI is launched, you can choose one of two options to start the design (see Figure 3-3).

Figure 3-3. GUI Offline Project Start Options
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3.2

Fusion GUI Online Mode
The Fusion GUI online mode can be launched by selecting Start menu → Texas Instruments → Texas
Instruments Fusion Digital Power Designer → Fusion Digital Power Designer. The GUI will discover one or
more devices connected to one or more USB-to-GPIO adapters.

3.2.1 No Adapter Found
If no USB adapter is connected to the PC, the screen in Figure 3-4 appears. Either connect the USB
adapter and try again or go to Offline mode.

Figure 3-4. No Adapter Found Message

3.2.2 No Device Found
If a USB adapter is connected to the PC but no device is found (see Figure 3-5), it may be due to one of
the following reasons:
• No devices are connected to the other end of the adapter.

Figure 3-5. No Device Found Message
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To detect the presence of supported TI devices on the PMBus, the Fusion GUI sends a list of known
PMBus commands (supported by the devices) to address 1 to 127 (skip 12). The Fusion GUI sets the
IDs of the devices based on the response from the devices. These known PMBus commands are
called Device Scan Mode in GUI. Users can select to scan for a specified address (or addresses) by
skipping all other addresses using the Device Scan Mode setting. Users can also select which
command (or commands) to send to the address to scan for devices (see Figure 3-6).
Different device scan modes are used to discover devices on the bus, as follows:
– DEVICE_ID (0xFD): Most UCD92XX and UCD90XX devices use this mode.
– DEVICE_CODE (0xFC): Most TPSxxxx devices use this mode.
– IC_DEVICE_ID (0xAD): Devices supporting PMBus 1.2 use this mode.
– Custom scan mode: some devices use PMBUS_REVISION (ReadByte 0x98) or MFR_MODEL
(ReadBlock 0x9A) as a way to identify themselves on the bus. Click the Scan for Device button to
customize the scan mode (see Figure 3-7).

Figure 3-6. Device Scan Editor
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Figure 3-7. Device Scan Help
•
•
•
•

Bus speed: the device may not support the bus speed setting, try a different speed (100 kHz and 400
kHz).
Packet error checking (PEC): the device may not support PEC. Try enabling and disabling PEC.
Pullup resistor needs adjusting
Check the resistor on the PMBUS_ADDR1 and PMBUS_ADDR2 pin to ensure they are compliant with
the data sheet requirement.
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Fusion GUI Layout
Figure 4-1 shows the Fusion GUI work flow.
• Build system: define your system in either online or offline mode. If active devices are connected to the
PC, you can begin monitoring and debugging your system.
• Configure system: configure each device in your system.
• Monitor and debug system: view the system responses.
• Save system: save the system configuration to a single system file (.tifsp), or save each device
configuration as individual configuration files (.xml, .csv, and .hex) for later use. If devices are online,
you can save the configuration of the device to its nonvolatile memory.
• Production: import the system file (.tifsp) or the configuration file of the device saved in the previous
bullet to devices using the Fusion MFR GUI, Fusion command line tools, or third-party programming.
Third Party
Programming

Fusion GUI Work Flow
Build
System

Configure

Monitor
Debug

Save to
File

MFG GUI

8VHUV¶ 2ZQ
Program
Calling
Fusion
Command
Line

Figure 4-1. Fusion GUI Work Flow
Figure 4-2 shows the system view.

Figure 4-2. Fusion GUI – System View
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4.1

Build System
Figure 4-3 shows the build mode selection. Here, you can perform the following:
• Create new Offline system from start: design a new system in off-line mode by adding one or more offline devices at a time. Select from an existing file (.xml or . tifsp), or a list of supported devices
embedded in the GUI. All devices in your system will be offline.
• Create new Offline system by opening existing system file: you have previously defined the system
and saved it in the system file (.tifsp) or a single project file (.xml). All devices in your system will be
off-line
• Modify existing system: add one or more off-line devices at a time by selecting from an existing file
(.xml or .tifsp), or selecting from a list of supported devices embedded in the GUI. This option can be a
hybrid mode, combining on-line devices from existing systems and newly added off-line devices.

Figure 4-3. Build System Mode Selection
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Debug System
System monitors provide an overview of the system (see Figure 4-4).
• Control panels: apply to all the devices and rails on the bus. If the setting is invalid for a rail or a
device, or it is nonwritable, the operation is skipped for that rail or device.
• Chart views: select a rail in the system to view the response data.
• Status view: LED on the device level indicates if the device status is OK or not. The LED in the rail
level indicates the status of the rail: fault, warning, or OK.
– The green LED indicates that the device has no fault and no warning at all.
– The red LED indicates that the device has a fault and warnings at either the rail or device level.
– The orange LED indicates that the device has warnings at either the rail level or device level.
• PMBus Logging: log the PMBus communication.
The system monitor has another important use, which is to single-step, turns on and turn off power rails.
Users can configure the On/Off Config of the rail, and toggle the Turn On and Immediate Off option to turn
on or off rails individually, so that all the rails are changed manually to discover any design issues (see
Figure 4-4).

Figure 4-4. Debug System Monitor
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4.3

Configure System
Figure 4-5 shows the configure system view.

Figure 4-5. Configure System View
1. Click the Click to configure device link to modify the configuration of the device. Different devices have
different views and tabs. See the device specification document for how to configure devices.
2. Navigate between rails (outputs): If the device supports multiple outputs, use the top-right-corner
combo box to navigate between rails.
• Online or Offline LED: device is connected (online) or device is not connected (offline)
• Write Pending to hardware: no pending write to hardware (RAM). You made changes in the GUI
but have not written to the hardware yet.
• Write Pending to NVM: no pending write to NVM (flash). Pending write to NVM. Since launching
the GUI, you made changes in the hardware (RAM) but have not stored the configuration to the
nonvolatile memory yet. The changes you make will be lost if the device is power cycled.
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4.3.1 Configure Task
The Configure Task provides the settings to configure the UCD90XXX device to function as designed (see
Figure 4-6). The task has Hardware Configuration, Rail Configuration, and Global Configuration tabs,
which are described in the following sections. Before starting the configuration, it is important to follow the
design flow. Consider the following:
• Rail setup: Number of rails to monitor and type of monitoring (voltage, current, temperature)
• Rail monitoring setup: Voltage, current, and temperature set points
• Rail control setup: Rails control (how are rails turned on and turned off)
• Rail margining setup: Number of rails requiring margining as well as the frequency and duty cycle
• GPI configuration: Are there digital signals (GPI) which must be monitored?
• Rail sequencing configuration: Start-up sequence; which rails come first, and which rails depend on
other rails for sequencing?
• Fault response configuration: How should the device act if a fault is detected (ignore the fault or act on
the fault)? If the device should act on the fault, how (shut down fault rail and other slave rails,
resequence, log the fault, and so on)?
• Logic GPO configuration: Are there output signals (LGPO) that must notify the external system?
• Other configurations: System watchdog and system reset

Figure 4-6. Hardware Configuration Task View
After making changes, do the following steps or the changes will be lost after the device is reset or power
cycled.

1. Click the Write to Hardware button to save changes into the RAM.
2. Click the Store RAM To Flash button to save changes into the Flash.
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4.3.1.1

Hardware Configuration

The UCD90xxx family supports various I/O capabilities (see Figure 4-7). The GUI lists the capacities at the
top-right corner of each I/O function (X of Y assigned), and Y is the capacity of the particular I/O function.
The Hardware Configuration tab lets users configure the I/Os as desired functions, such as monitoring,
GPI, logic GPO (LGPO), margining, and more. Users must perform the hardware configuration first.

Figure 4-7. Hardware Configuration

4.3.1.1.1 Configuring Rails – Monitoring, Enabling, and Margining
Each rail can have up to five pins: voltage, temperature, current, enable, and trim/margin (see Figure 4-8).
The voltage, temperature, and current pin assigns a monitor pin to perform voltage, temperature, and
current monitoring, respectively. The enable pin is an output signal to enable and disable the downstream
power supply. The trip/margin pin is the PWM output signal to margin the desired voltage rail. The user
can also configure a rail with the enable pin only. A rail without any pins is forbidden.

Figure 4-8. Configure Rails
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Users must click Add Rail to add a new rail, then click the Configure button, to configure the monitor type
and polarity of the enable signal and margining settings (duty cycle, frequency, mode, and so on) as
shown in Figure 4-9.

Figure 4-9. Configure New Rails
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4.3.1.1.2 Configuring General-Purpose Inputs (GPIs)
GPIs are mainly used to receive signals from the external system. Click the Add GPI button to add a GPI,
then click the Configure button to set the polarity and other GPI functions (see Figure 4-10). GPI functions
vary by device (see Figure 4-12, Figure 4-13, and Figure 4-11). See the data sheet for function details.
Moreover, the GUI provides a description next to each function to help customers understand the feature.

Figure 4-10. Configure GPIs

Pin Polarity

Must Be Set To Enable GPI Logging,
Fault Shutdown And Fault Pin Functions.

GPI For Margin

GPI Fault Response
Response Actions

Sequencing Debug Pin

Fault Pin Configuration

Cold Boot Settings

Figure 4-11. GPI Configuration for Rest UCD9090A and UCD90160A
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Pin Polarity

Must Be Set To Enable GPI Logging,
Fault Shutdown And Fault Pin Functions.

GPI For Margin

Sequencing Debug

Fault Pin Configuration
(UCD90320 only)

Figure 4-12. GPI Configuration for UCD90240 and UCD90320

Pin Polarity

Must Be Set To Enable GPI Logging

GPI For Margin

Figure 4-13. GPI Configuration for Rest UCD90xxx
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4.3.1.1.3 Configuring Boolean Logic-Controlled GPOs (LGPO)
UC90xxx devices can output signals based on the combined results of Boolean logic from the GPIs state,
Rails state, and other LGPOs state (see Figure 4-14). Users can also configure a LGPO without a physical
output pin, a virtual LGPO. The virtual LGPO is typically used as an input for other LGPO to save a
physical pin.

Figure 4-14. Configure Boolean Logic-Controlled LGPOs
Click the Add Logic Controlled GPO button to add a LGPO, then click the Configure button (see Figure 414). Each LGPO has two AND paths and one final OR gate with an inverter on each (see Figure 4-15).

Figure 4-15. Add Logic-Controlled GPO
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Users can select the combination of GPI, GPO, and Rail inputs (see Figure 4-16).

Figure 4-16. Logic GPO Input Selection

4.3.1.1.4 Configuring Command Controlled GPOs
Command Controlled GPOs are the output with a fixed state unless users issue a PMBus command to
change it (see Figure 4-17).

Figure 4-17. Configure Command Controlled GPOs

4.3.1.1.5 Configuration Fans
Some UCD90xxx sequencers have a built-in fan controller, enabled by combining Tach monitor inputs,
PWM output, and temperature measurements (see Figure 4-18). For the details on fan control, see the
data sheet.

Figure 4-18. Fans
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First click the Add Fan button and then click the Configure button, as shown in Figure 4-18. On the pop-up
window (see Figure 4-19), customers can configure the following settings for the fan functions:
• PWM
• Speed
• Speed Type
• Duty Cycle
• Tach input
• Auto Adjust Fan Speed to Temperature
• Fault Response

Figure 4-19. Fan Configurations
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4.3.1.1.6 Configuring General-Purpose Pulse-Width Modulation (PWM)
General-purpose pulse-width modulation are the PWM output with a fixed duty cycle, frequency, and
phase until users make changes with commands (see Figure 4-20).

Figure 4-20. Configure General-Purpose PWM

4.3.1.1.7 Configuring Manufacturing Information
The device information includes the following:
• Device part ID
• Firmware version
• IC package
• PMBus Revision and Manufacturing Information
Among these, users can customize manufacturing information to suit their needs, such as configuration
version control (see Figure 4-21).

Figure 4-21. Configure Manufacturing Information
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4.3.1.2

Rail Configuration

The Rail Configuration tab (see Figure 4-23) includes all the settings related to the rails including:
thresholds, sequencing conditions, fault responses, and scaling. Based on the user's inputs, the GUI plots
rail sequences on and off timing in real time. Moreover the GUI also provides a snapshot of rail settings;
users can double click the target rail to modify it.
4.3.1.2.1 Voltage, Current, Temperature Limits, and Scaling Settings
Figure 4-22 shows how the rail jumps among different states with the settings.

INIT

TOFF_MAX_WARNING
expiring

IDLE
(EN deasserted)

ON condition met
with dependencies

Dependencies met, no delay,
no TOFF_MAX_WANING
RAMP_DOWN
(EN deasserted)

Delay expired, no
TOFF_MAX_WARNING
SEQ_ON
(EN deasserted)

Delay expired, with
TOFF_MAX_WARNING

ON condition met, no
dependencies but with delay

Dependencies met, no
delay, with
TOFF_MAX_WARNING

Dependencies met,
with TON_DELAY
Dependencies met
with TOFF_DELAY

Dependencies met,
no TON_DELAY

TON_DELAY
(EN deasserted)

TOFF_DELAY
(EN asserted)

SEQ_OFF
(EN asserted)

ON condition met, no
dependencies, no delay

OFF condition met, no
dependencies, with delay
Delay expired

OFF condition met, no
dependencies, no delay,
with TOFF_MAX_WARNING

OFF condition met, no
dependencies, no delay,
no TOFF_MAX_WARNING

RAMP_UP
(EN asserted)

OFF condition met
with dependencies
Voltage over
POWER_GOOD threshold

REGULATED
(EN asserted)

Figure 4-22. State Machine
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Figure 4-23 shows the Rail Configuration screen.

Figure 4-23. Rail Configuration Tab

4.3.1.2.1.1 Setting Voltage Setpoint, Margin, and Limits
Each rail can have up to nine different thresholds for each voltage rail, as follows:
• OVER_VOLTAGE_FAULT
• OVER_VOLTAGE_WARNING
• UNDER_VOLTAGE_FAULT
• UNDER_VOLTAGE_WARNING
• MARGIN_HIGH
• MARGIN_LOW
• POWER_GOOD_ON
• POWER_GOOD_OFF
• VOUT
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The GUI can help to synchronize the margins, limits, and PG to the VOUT, to save the user's inputs (see
Figure 4-24). The Vout Exponent defines the maximum value the device can detect. When the Set for me
checkbox is selected, the GUI automatically adjusts the Vout Exponent based on the user's inputs to
achieve the best resolution. If the thresholds are larger than the maximum value allowed by the Vout
Exponent, 0 V is returned by the device. All of these thresholds are the results after the scaling factor and
offset defined in Section 4.3.1.2.1.2.

Figure 4-24. Voltage Setpoint, Margin, and Limit Setting for Rest UCD90xxx
The UCD90320 device supports up to 4 profiles (each profile has 9 thresholds) per rail, to support different
CPU skews. Users can click the Edit Rail Profile link to add, delete, or modify existing profiles (see
Figure 4-25).

Figure 4-25. Voltage Setpoint, Margin, and Limit Setting for UCD90320
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4.3.1.2.1.2 Setting Scaling Factors
Each rail has its own scaling factor and offset for voltage, current, and temperature. Set the scaling factors
based on the hardware design. The thresholds set in Section 4.3.1.2.1.1 are after scaling factor and offset.
The Vout Scale Mon is normally the ratio of the external voltage divider if applicable. For example, a 12-V
rail is down-scaled to 2 V using a divider connected on the Mon pin. The Vout Scale Mon must be set to
2/12 (1/6) and all the thresholds set in Section 4.3.1.2.1.1 shall be based on the 12 V instead of the 2 V.

Figure 4-26. Scaling Factors Setting

4.3.1.2.1.3 Setting Current and Temperature Limits
When rails are configured to monitor current and temperature, limits can also be set (see Figure 4-27).

Figure 4-27. Current and Temperature Limits Setting
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4.3.1.2.2 Sequencing
4.3.1.2.2.1 Turning Rails On and Off
Each rail has an On/Off Config setting, the Turn On/Off Delay and the Max Turn On/Off, to meet different
power-up requirements (see Figure 4-28). The Turn On/Off Delay is the delay time to assert or deassert
the enable signal after the On/Off condition is met. Max Turn On sets an upper limit, in ms, on how long
the power supply can try to power up the output without reaching the POWER_GOOD_ON voltage level.
Max Turn Off sets an upper limit, in ms, on how long the power supply can try to power down the output
without reaching 12.5% of the output voltage programmed.

Figure 4-28. Rail On/Off Config Setting (1/2)
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Figure 4-29 shows the Rail On/Off Config options.

(1)

None (auto enable): the rail automatically tries to turn on when the UCD90xxx device is out of reset. In auto
mode, the rail does not tries to turn off.

(2)

CONTROL Pin Only: the rail tries to turn on or off when the CONTROL pin state is toggled.

(3)

OPERATION Only: the rail tries to turn on or off when it receives an OPERATION command. If the PIN
SELECTED RAIL STATE (PSRS) feature is used, the rail must be configured as OPERATION.

Figure 4-29. Rail On/Off Config Setting (2/2)
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4.3.1.2.3 Setting Sequencing Time-Outs and Dependencies
Sequencing is very critical for the modern power system. Which rails should be on first? Are there any
dependencies? Which rail should be off last? UCD sequencers provide very flexible configuration for the
sequencing (see Figure 4-30). A rail can have dependencies on other rails, GPIs, and logical GPOs, to
meet various sequencing conditions (see Table 4-1). To prevent the dead loop case, users can set a
proper time-out value to decide what action to take: wait forever, turn on, or resequencing when the timeout expires.
Table 4-1. Sequencing Dependencies Events
Event

Rail

GPI

LGPO (1)

Sequence On condition met

Voltage monitoring: Above
POWER_GOOD threshold
Other monitoring: EN signal is asserted.

Asserted (2)

The logic output is TRUE.

Sequence Off condition met

Voltage monitoring: Below
POWER_GOOD_OFF threshold
Other monitoring: EN signal is
deasserted.

Deasserted (2)

The logic output is FALSE.

(1)
(2)

LGPO dependencies are available only on UCD90320, UCD90160A, and UCD9090A devices.
The input signal is asserted if it matches the defined polarity, otherwise it is deasserted.

Figure 4-30. Sequencing Time-Out and Dependencies Setting

4.3.1.2.3.1 Using Fault Shutdown Slaves
Fault shutdown slaves are the slave rails of the faulted rail. Each rail can have its own fault slave rails (as
shown in Figure 4-31). When a fault occurs on the master rail, if its response is to shut down, all slave
rails are also shut down. If retries are specified for the master rail, the slave rail (or rails) remain running
until all retries are exhausted. For the UCD90120 and UCD90124 devices, the slave pages are shut down
in the same way as the master page. For devices other than the UCD90120 and UCD90124, the slave
pages are shut down using sequence off dependencies and TOFF_DELAY. The slave pages do not
perform any retries during the fault slave shutdown. After being shut down, slave rails are latched off as if
they had experienced the fault. A status bit is set in their MFR_STATUS word indicating the reason they
are latched off. If a resequence is enabled on the fault response of the master rail, the fault shutdown
slaves are resequenced along with master rail.
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If the fault response of master rail is set to ignore and continue operation, the fault shutdown slaves are
meaningless.

Figure 4-31. Fault Shutdown Slaves

4.3.1.2.4 Setting Fault Responses
This section describes how to set up fault responses to protect the system when faults are detected. The
GUI provides a convenient way to configure the fault response. Figure 4-32 and Figure 4-33 show a
snapshot of the fault responses. By clicking the Edit in larger window link, the user can configure each
fault individually.

Click To See
Action

Non-GPI Fault
Response

GPI Profile Selection

Clock to See Action

GPI Fault
Response

Figure 4-32. Fault Response Setting For UCD90240 and UCD90320

Figure 4-33. Fault Responses Setting For Rest UCD90xxx
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For each fault, there are different actions (see Figure 4-34).

(1)
•
•

(2)
•
•
•

Response:

If ignore is selected, the reset settings are ignored.
The faulted rail is turned off immediately.
The fault rail is turned off based on its sequencing.
(3)

•

Options:

The glitch filter is used to filter out expected noise so that the response is taken on the real fault. The fault is still
logged regardless of the filter.
Resequence the faulted rail and its fault shutdown slaves after a programmable delay when the retry is
exhausted. Resequence starts after the retry is exhausted.

Restart:

Retry settings. The retry count is reset whenever the rail stays above POWER_GOOD for a
TON_MAX_FAULT_LIMIT amount of time without having a glitch. If TON_MAX_FAULT_LIMIT is set to 0, 4
seconds are used for the time. There is only one retry for the UV fault because the retry is not considered
completed until the rail reaches the POWER_GOOD threshold again.

Figure 4-34. Fault Response Actions
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The settings related to the resequence are detailed under the Global Configuration tab (see Figure 4-35).

Figure 4-35. Resequence Settings

4.3.1.2.5 SMBAlert Mask
This feature prevents the SMBALERT# signal being asserted, based on the selected status bit (see
Figure 4-36). Only UCD90240 and UCD90320 devices have this feature.

Figure 4-36. SMBAlert Mask
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4.3.1.3

Global Configuration

Global Configuration is meant to configure the rest of the functions of the devices including: Enable Fault
Log, Misc Config, System Reset, System Watchdog, Pin Selected Rail States, Fault Pin Config, and Run
Time Clock (see Figure 4-37).

Figure 4-37. Global Configuration
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4.3.1.3.1 Enabling the Fault Log
Users can configure which faults get written to the detail fault log in the nonvolatile flash memory. The
checkboxes select the fault to be written (see Figure 4-38). This only affects detail fault logging. Faults are
always written to the logged fault summary in the flash memory. A limited number of faults can be logged
in the details; this number varies by devices.

Figure 4-38. Enable Fault Log
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4.3.1.3.2 MISC_CONFIG
The MISC_CONFIG function lets users configure the following features (see Figure 4-39). Features vary
by device (see individual UCD90xxx data sheets for supported features).
• Resequencing
• Fault log FIFO mode
• Brownout logging
• Disable flash logging
• Fan control
• External ADC reference
• Manual temperature settings

Figure 4-39. MISC_CONFIG Function
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4.3.1.3.3 Configuring System Reset Output
The system reset function lets the device provide an external reset signal to the system. The signal can be
based on time, the power-good state of selected rails, the state of selected GPIs, or a combination of
these. This ensures that key devices (such as the CPU and FPGA) are held in reset until other dependent
devices are fully powered (see Figure 4-40).
Users must select an I/O as a reset output, the polarity and mode are configurable. Select the rails or
GPIs which impact the system reset signal. A reset can also be generated as a result of a system
watchdog time-out if the checkbox is selected.
The GPI tracking function lets the system reset pin be more precisely influenced by a specific GPI pin.
(The GPI pin may be a reset signal from another device or a pushbutton.) Whenever the GPI deasserts,
the system reset immediately asserts. When the GPI asserts, the system reset is held asserted for the
GPI Tracking Release Delay time. After this delay time, the system reset is deasserted.

Figure 4-40. Configure System Reset Output
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4.3.1.3.4 Configuring the System Watchdog
The system watchdog function keeps a time-out counter running. That counter is reset when the watchdog
input (WDI) is toggled or when the SYSTEM_WATCHDOG_RESET command is written. If the counter is
not periodically reset within the amount of time configured in the following reset period, the watchdog
output (WDO) pin is asserted. The WDO pin stays asserted until the WDI pin is toggled or until the
SYSTEM_WATCHDOG_RESET command is written. The WDI and WDO pins are optional, except for
UCD90120 and UCD90124 devices (see Figure 4-41).
The start time is the time to delay before monitoring the WDI pin or command. The Watch Reset Pin and
the Disable until System Reset Release options can be used to disable or enable the system watchdog
function based on the system reset signal.

Figure 4-41. Configure System Watchdog
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4.3.1.3.5 Pin Selected Rail States (PSRS)
PSRS use up to three GPI inputs to determine the state of the rails (system state) to support the ACPI
(advanced configuration and power interface). With each system state, up to eight rails can be set to on or
off to meet system requirements (see Figure 4-42). Only the first three GPIs are used to determine the
states. The rails that are set as on or off must be configured using the OPERATION command to use
PSRS.

Figure 4-42. Pin Selected Rail States
When the number of GPIs used for PSRS is less than the number of configured GPIs, enable all
supported states based on the number of configured GPI and configure the state based on the number of
GPI for PSRS. For example, three GPIs are configured, but only the first GPI is used for PSRS. Users
must enable all eight states; configure all even states the same as state 0 and configure all odd states the
same as state 1. Therefore the changes on the second and third GPI do not affect the desired function.
4.3.1.3.6 Fault Pins Config
Fault Pin Config is valid only on UCD90240 and UCD90320 devices. For the UCD90240 device, users can
select which pin is the Fault pin (highlighted by the black square); on the UCD90320, the fault pin
selection is part of GPI pin configuration, therefore the black square is grayed-out on the UCD90320
device (see Figure 4-43). From the fault pin configure, users can configure which pages have impact on
the fault pin output.

Figure 4-43. Configure Fault Pins
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4.3.1.3.7 Run-Time Clock
The run-time clock is the time used within data flash-based fault logging to note the time that a fault
occurred. The run-time clock starts from 0, but an external processor sets the run-time clock to real-word
time. See the UCD90XXX PMBus Command Reference Guide for the details.

4.3.2 Monitor Task
The Monitor task provides a real-time status of the rails and I/Os. Using the checkboxes in the upper-left
corner, users can choose which property plot (voltage, current, temperature, and GPIO) should be visible
for the given rail (see Figure 4-44). Changes to Control Line, Operation, and Margining take effect
immediate without clicking the Write to Hardware button. Users can choose either target rail or device
from the drop-down menu at the top-right corner.

Figure 4-44. Monitor Task Screen
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Device (Rail) Dashboard

The rail dashboard provides an overview of the selected rail (see Figure 4-45). The dashboard lists
property values of all rails, the current rail status, and the control pin/operation command (including
margining).

Figure 4-45. Rail Dashboard
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4.3.3 Status Task
The status task shows the current status registers, fault log, peak log, misc status, and blackbox log (see
Figure 4-46). Users can clear faults, logged faults, logged peaks, and blackbox using different buttons on
the left-side panel. Users can read the status of different rails from the pulldown menu at the top-right
corner of the status task.
• The Status Registers tab shows the status of the rail and system, where STATUS_WORD,
STATUS_CML, and MFR_STTATUS are global instead of page-based.
• The Logged Faults tab shows all faults logged since the last clearing.
• The Peak Readings tab shows all peak values of all monitor rails since the last clearing.
• The Misc Status tab shows device reset tracking
• The Blackbox Info tab shows a snapshot of the system from when the first fault is detected to the last
clearing (this feature is available only for UCD90240 and UCD90320 products).

Figure 4-46. Status Task Screen
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4.3.4 Security Task
The Security Task lets users prevent certain commands from being modified without authorization (see
Figure 4-47). For the devices that do not support SECURITY_BIT_MASK, the protected commands are
fixed. See the UCD90XXX PMBUS Command Reference Guide for details.
In the GUI, the user must input 6-character (not byte) passwords; for example, if the user enters 123456,
the GUI sends the 0x313233343536 password to the device using MFR_SPECIFIC_33 (0xF1) to enable
the feature. When security is enabled, the feature can be temporarily disabled by writing the password to
this command. The feature can be permanently disabled by first disabling security, then setting the
password to [0xFFFFFFFFFFFF], and clicking Store RAM to Flash. For security reasons, the password
cannot be read back.

Figure 4-47. Security Task Screen
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Import and Export Configurations
The Fusion GUI can import and export configurations from various formats. These configurations are done
from the File Menu. The format for importing and exporting configurations differs depending on online or
offline mode and also the devices. The configuration of an individual device can be saved in the project
file or saved as a single system file (.tifsp). Users can choose whether to store all settings to the data flash
and/or to clear the flash logs before exporting the data flash, as shown in Figure 5-1 (see the Global
Options tab).

Figure 5-1. Configuration Storage Setting
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File Formats
The Fusion GUI supports the following file formats (see Figure 5-2):
• Project file (.xml): used by the Fusion GUI; stores the configuration of a single device, and nondevice’s definition such as rail names. Project file can be saved in device’s configuration window, File
menu → Save Project As
• System file (.tifsp): used by the Fusion GUI; stores configurations of multiple devices. System file can
be saved in the system configuration window, using the save button or File menu.
• Flash file (on-line device and device has flash): contain raw binary flash data. Flash file is a single
device’s configuration, and can be saved in the configuration window of the device, File menu →
Export. TI recommends using the data flash (.hex) format to import into the new device.
– Data Flash: text (.txt), Intel Hex (.hex), or S-Record (.srec)
– Program Flash: Intel Hex (.hex), S-Record (.srec), and Tektronix Extended Format (.x0). The SRecord and Intel Hex file can be used by both EEPROM/JTAG programmers and the Fusion GUI.
The Tektronix format is only for the Fusion GUI.
• Script file: Sequence of I2C, SMBus, and PMBus commands used to configure the device. File formats
are text (.txt), and Excel (.csv), and can be used by both third-party programmers and the Fusion GUI.
– PMBus Write Script File: writes to RAM and takes effect immediately
– Data Flash Script File: writes to Data Flash and takes effect until reset
• JTAG file(.svf): used by the external JTAG programmer; the configuration of a device from either the
active device or a hex file is saved in serial vector format (SVF).

Figure 5-2. Supported File Formats
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5.2

Device Report
The Fusion GUI can generate a file (Excel or HTML format) to report the basic configuration of the device.
The report file can be generated using the Device Report tab (see Figure 5-3).

Figure 5-3. Device Report (1/2)
The file gives users a complete view of the entire configuration of the rail (PINs, threshold/limits,
dependencies, timing, and fault response). Currently, the file does not include other settings, such as GPI,
LGPO, and global configurations (see Figure 5-4).

Figure 5-4. Device Report (2/2)
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Fusion GUI Useful Tools
6.1

Preferences
Go to File menu → Preferences… (see Figure 6-1).
• Show or hide the All Config tab.
• Enable or disable the protected feature (need password to show the protected feature).
• Delete all application preferences.
• Show warnings or confirmation dialog messages: some warnings and confirmation dialog pop-ups from
the GUI are discarded and not shown again by the users selection. Clicking this button enables these
pop-up dialog boxes again.
• Configure Device Scan Mode and Address.
• Delete all application preferences when the Fusion GUI closes. The GUI does not keep the user
preferences each time it is launched. The GUI treats each as first-time users.
• Delete rail names and pin names when the GUI closes (only rail names and pin names are deleted).

Figure 6-1. Preferences
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6.2

Background Polling
By default, the GUI polls various information from devices, and updates this information in the GUI (for
example, plots). This feature can be seen turned on and off, as shown in Figure 6-2.

Figure 6-2. Background Polling [System View]
Or the feature can be turned on and off using the system monitor toolbar (see Figure 6-3).

Figure 6-3. Background Polling [System Monitor]

NOTE: Background polling should be disabled if other hosts have access to the device.
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Polling Status
Figure 6-4 and Figure 6-5 show on-screen displays of the polling status for the system and for each
device.

Figure 6-4. System Polling Status

Figure 6-5. Device Polling Status
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6.4

Copy or Clone Rails
The Clone and Copy features (select File → Tools → Copy/Clone Rails …) help users copy the following
settings of a sourcing rail: Voltage Parameters, Fault Responses, Turn On and Turn Off Timing, Sequence
ON and OFF Timing, Sequence ON and OFF GPI pin, Enable Pin Setup, Margining Pin Setup, On Off
Config, Fault Logging, as well as Current and Temperature Parameters (see Figure 6-6).

Figure 6-6. Copy or Clone Rails Screen

6.5

PMBus Logging
The Fusion GUI can save all the PMBus commands from the USB adapter host to a local file if these are
required for debugging purposes (see Figure 6-7). This feature is only available in online mode.

Figure 6-7. PMBus Logging
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Data Logging
Data logging is used to turn on the poll for a selected command, and the values are logged to one or more
text files (see Figure 6-8). Unlike the PMBus logging utility, this feature enables polling of selected
commands always, even if the monitor task has never been selected.

Figure 6-8. Data Logging

6.7

Device and Project Configuration Comparison
Users can compare the configuration stored in the project file (.xml) and the current configuration loaded
on the device (online or offline), or compare the configurations between project files (see Figure 6-9).

Figure 6-9. Device and Project Configuration Comparison
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The tool is highly flexible when providing the combinations to compare and results to display (see
Figure 6-10).

The differences in Category: Status can be ignored because the I/O status can be different.

Figure 6-10. Comparison Tool Results

6.8

UCD3xxx and UCD90xxx Device GUI
The Fusion GUI also provides a low-level GUI debug tool, which includes links to many different tools
together (see Figure 6-11). This GUI cannot coexist with the Fusion GUI.
SMBUs/I2C Low

Figure 6-11. UCD3xxx and UCD90XXX Device GUI
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The Device GUI can help users scan the device on the same I2C bus, download Firmware, as well as
dump, export, and compare flash files and other uses (see Figure 6-12).

Figure 6-12. Device GUI Settings

6.9

SMBUS, I2C, and SAA Tool
The SMBUS, I2C, and SAA tool provides a very low-level I2C utility, which can be used for any I2C devices
in addition to the UCD90xxx (see Figure 6-13). There any different ways to launch this utility. Be sure to
stop the polling from the Fusion GUI if the tool is launched from there.

Figure 6-13. SMBUS, I2C, and SAA Toolbar Launch
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The SMBUS, I2C, and SAA tool can also be launched from the Device GUI described in Section 6.8 (see
Figure 6-14).

Figure 6-14. SMBUS, I2C, and SAA Tool GUI Launch
The last method to launch this tool is using the Start menu (see Figure 6-15).

Figure 6-15. SMBUS, I2C, and SAA Tool Start Menu Launch
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Users must enter the PMBus address of the device in the Device Address box before advancing further
(see Figure 6-16). See the SMBus Specification, PMBus Specification, and UCD90XXX PMBus Command
Reference GUI to understand the protocol and commands.

Figure 6-16. Device PMBus Address
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6.10 SAA Settings
Users can configure the TI USB-to-GPIO adapter to disable or enable PEC as well as change the I2C
speed and pullup resistors values. This utility can be launched from the SMBUs, I2C, SAA tool, in the topright corner or the Tool menu (see Figure 6-17 and Figure 6-18).

Figure 6-17. SAA Settings (1/2)

Figure 6-18. SAA Settings (2/2)
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Configuration Examples
The following provides example considerations for configuring UCD90xxx devices.

7.1

Design Flow
•

•
•
•

•
•

•

•
•
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Rail setup:
– How many rails must be monitored?
– What type of monitoring (voltage, current, temperature)?
Rail monitoring setup:
– What are the voltage, current, and temperature set points?
Rail control setup:
– How are the rails controlled (turned on and turned off)?
Rail margining setup:
– How many rails require margining?
– What is the frequency and duty cycle?
GPI configuration:
– Are there digital signals (GPI) that must be monitored?
Rail sequencing configuration:
– What is the start-up sequence?
– Which rails come first?
– Which rails depend on other rails for sequencing?
Fault response configuration:
– How should the device act if a fault is detected?
– Should the device Ignore the Fault or Act on Fault?
– If the device should Act on Fault, and which action to take (shut down fault rail and other slave rails,
resequence, log the fault, and so on)?
Logic GPO configuration:
– Are there output signals (LGPO) that must notify external system?
Other configurations:
– System watchdog
– System reset
– Faults to log
– Fan control
– FIFO log mode
– Resequencing settings

Configuration Examples
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7.2

Hardware Configuration
When the previous questions are answered, go to Configure → Hardware Configuration to perform the
following steps:
1. Create rails to monitor – either voltage, current, temperature, or all.
2. Assign GPIO pins to be used as the enable pin, monitoring rail status such as: rail is on, rail is off.
3. Assign PWM pins for margining.
4. Assign GPI pins to monitor the external event.
5. Assign LGPOs to output the status.
6. Configure the device information.

7.3

Rail Configuration
When all the hardware pins are assigned, go to Configure → Rail Config to perform the following steps:
1. Configure the voltage, current, temperature limit, and scaling.
2. Set the proper turnon or turnoff delay.
3. Configure sequencing (how are rails turned on and off? Which rails should turn on first? Are there any
dependencies.)
4. Go to Global Configuration → PIN SELECTED RAIL STATES, if needed.
5. Configure Fault Responses (rails response to faults).

7.4

Global Configuration
When all the rails are configured properly, the last step is to go to Config → Global Configuration to see
whether the following features are required.
• Enable Fault Logging: See which faults must be logged to save more important logs.
• Misc Config: Set the resequence option, brownout option, Fault logging scheme (FIFO mode, fan
control and external ADC) when they are applicable and required.
• System Reset: Set the proper system reset if this feature is required.
• System Watchdog: Configure the system watchdog if this feature is required.
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